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Operating Instructions

Introduction

To get maximum versatility from this machine all operators should carefully read and follow the in-
structions in this manual. Please keep this manual in a handy place near the printer.

Please read the Safety Information before using this printer. It contains important information related
to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Parts of this manual are subject to change without prior notice. In no event will the company be liable
for direct, indirect, special, incidental, or consequential damages as a result of handling or operating the
machine.

Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe® and PostScript® are registered trademarks of Adobe Systems Incorporated.

Appletalk, Apple, Macintosh is a registered trademark of Apple Computer, Incorporated.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

Notes:

Some illustrations might be slightly different from your machine.

Certain options might not be available in some countries. For details, please contact your local dealer.
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Installing the PostScript Printer Driver

This section describes basic instructions for installing the printer driver. The actual procedure may dif-

fer depending on the operating system. Follow one of the appropriate procedures below.

Important

❒ Before updating the printer driver by installing the latest version, you should uninstall any former ver-

sion first. See the Printer Client Reference 2.

Windows 95/98/Me - Installing the PostScript Printer Driver

Installing the printer driver

Important

❒ Be sure to install the PPD file for Windows 95/98/Me. Do not accidentally install the PPD file for Win-

dows 2000 or Windows NT 4.0.

AAAA Close all applications that are currently running.

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

CCCC Double-click the [Add Printers] icon.

[Add Printer Wizard] starts.

DDDD Click [Next].
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EEEE Click [Local Printer], and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.

FFFF Click [Have Disk].

A dialog box for installing the printer driver from a disk appears.

GGGG Hold down the {{{{SHIFT}}}} key and insert the CD-ROM into the CD-ROM drive. Keep the

{{{{SHIFT}}}} key held down until the computer has finished accessing the CD-ROM.

If the Auto Run program starts, click [Cancel].

HHHH Click [Browse].

IIII Select the CD-ROM in the [Drives:] list box.

JJJJ In the [Folders:] box, double-click [DRIVERS], [PS], [WIN9X_ME]. Then double-click the folder

of the appropriate language for the operating system. Finally, click [DISK1].

KKKK Click [Open].

LLLL Click [OK].

MMMM Click to select the name of the printer whose driver you want to install, and then click [Next].

NNNN In the [Available ports:] box, click to select [Printer Port], and then click [Next].

OOOO Change the name of the printer if you want, and then click [Next].

PPPP Select whether or not you want to print a test page, and then click [Finish].

QQQQ If you are asked whether you want to restart Windows, select [Yes]. If you are not asked, re-

start Windows after completing the installation.
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Setting up options

Important

❒ If the printer is equipped with certain options (e.g. the Paper Feed Unit or the Memory Unit), you

should set up the options with the printer driver.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

DDDD Click the [Accessories] tab.

EEEE In the [Options] group, select the option you have installed on the printer.

FFFF Use the [Change settings for:] list box to select the appropriate setting for the selected option.

GGGG Click [Apply] to apply the settings you made.

HHHH Repeat steps EEEE – GGGG for all options.

IIII After making all settings for options, click [OK].
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Windows 2000 - Installing the PostScript Printer Driver

Installing the printer driver

Limitation

❒ Installing a printer driver requires Manage Printers permission. Members of the Administrators, and

Power Users groups have Manage Printers permission by default. When you install a printer driver,

log on using an account that has Manage Printers permission.

Important

❒ Be sure to install the PPD file for Windows 2000. Do not accidentally install the PPD file for Windows

95/98/Me or Windows NT 4.0.

AAAA Close all applications that are currently running.

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

CCCC Double-click the [Add Printers] icon.

[Add Printer Wizard] starts.

DDDD After confirming that the [Local Printer] option is selected, click [Next].

A dialog box for selecting the printer port appears.

EEEE Select the check box of the port you want to use, and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.

FFFF Click [Have Disk].

A dialog box for installing the driver from a disk appears.
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GGGG Hold down the left {{{{SHIFT}}}} key and insert the CD-ROM into the CD-ROM drive. Keep the

left {{{{SHIFT}}}} key held down until the computer has finished accessing the CD-ROM.

If the Auto Run program starts, click [Cancel].

HHHH Change the drive name in the list box to the name of the CD-ROM drive, and then click

[Browse].

IIII In the [Folders:] box, double-click [DRIVERS], [PS], [WIN2000]. Then double-click the folder of

the appropriate language for the operating system. Finally, click [DISK1].

JJJJ Click [Open].

KKKK Click [OK].

A printer model selection dialog box appears.

LLLL Click to select the name of the printer whose driver you want to install, and then click [Next].

A dialog box for changing the printer name appears.

MMMM Change the name of the printer if you want, and then click [Next].

NNNN Click [Next].

OOOO In the next dialog box you will be asked to print a test page, select [No], and then click [Next].

A confirmation dialog box appears.

PPPP Confirm the settings you have set, and then click [Finish].

The installer copies the printer driver files from the CD-ROM to the computer's hard disk.

QQQQ Set up the options with the printer driver.
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RRRR Restart Windows.

Note

❒ Print a test page after completing installation.

Setting up options

Limitation

❒ Changing the setting of the printer requires Manage Printers permission. Members of the Adminis-

trators and Power Users groups have Manage Printers permission by default. When you set up op-

tions, log on using an account that has Manage Printers permission.

Important

❒ If the printer is equipped with certain options (e.g. the Paper Feed Unit or the Memory Unit), you

should set up the options with the printer driver.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use. On the [File] menu, click [Properties].

CCCC Click the [Device Settings] tab.

DDDD Click the installed option in the [Installable Options] box, and then select [Installed] or [Not In-

stalled] from the drop-down list box.

EEEE Repeat step DDDD for all options.

FFFF After making all settings you want, click [OK].



Operating Instructions

10

Windows NT 4.0 - Installing the PostScript Printer Driver

Installing the printer driver

Limitation

❒ Installing a printer driver requires Full Control access permission. Members of the Administrators,

Server Operators, Print Operators, and Power Users groups have Full Control permission by de-

fault. When you install a printer driver, log on using an account that has Full Control permission.

Important

❒ The CD-ROM containing the Windows NT Server operating system version 4.0, or the Windows NT

Workstation operating system is required for installing the printer driver.

❒ We recommend that you upgrade the Windows NT 4.0 operating system to Service Pack 4 or later

before installing the printer driver. Contact your Windows retailer for more information about the lat-

est version available.

❒ Be sure to install the PPD file for Windows NT 4.0. Do not accidentally install the PPD file for Win-

dows 95/98/Me or Windows 2000.

AAAA Close all applications that are currently running.

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

CCCC Double-click the [Add Printers] icon.

[Add Printer Wizard] starts.

DDDD After confirming that the [My Computer] option is selected, click [Next].

A dialog box for selecting the printer port appears.
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EEEE Select the check box of the port you want to use, and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.

FFFF Click [Have Disk].

A dialog box for installing the driver from a disk appears.

GGGG Hold down the {{{{SHIFT}}}} key and insert the CD-ROM into the CD-ROM drive. Keep the

{{{{SHIFT}}}} key held down until the computer has finished accessing the CD-ROM.

If the Auto Run program starts, click [Cancel].

HHHH Change the drive name in the list box to the name of the CD-ROM drive, and then click

[Browse].

IIII In the [Folders:] box, double-click [DRIVERS], [PS], [NT4]. Then double-click the folder of the

appropriate language for the operating system. Finally, click [DISK1].

JJJJ Click [Open].

KKKK Click [OK].

A printer model selection dialog box appears.

LLLL Click to select the name of the printer whose driver you want to install, and then click [Next].

A dialog box for changing the printer name appears.

MMMM Change the name of the printer if you want, and then click [Next].

NNNN Click [Next].

OOOO In the next dialog box asking if you want to print a test page, select [No] and then click [Finish].

The installer copies the printer driver files from the CD-ROM to the computer's hard disk.
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Note

❒ Print a test page after completing installation and restarting Windows.

PPPP If you are asked whether you want to restart Windows, select [Yes]. If you are not asked, re-

start Windows after completing the installation.

Setting up options

Limitation

❒ Changing the setting of the printer requires Full Control access permission. Members of the Admin-

istrators, Server Operators, Print Operators, and Power Users groups have Full Control permission

by default. When you setup options, log on using an account that has Full Control permission.

Important

❒ If the printer is equipped with certain options (e.g. the Paper Feed Unit or the Memory Unit), you

should set up the options with the printer driver.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

DDDD Click the [Device Settings] tab.

EEEE In the [Installable Options] group, select the option you have installed on the printer.

The current setting appears in the [Change Setting] box.
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FFFF Use the [Change Setting:] list to select the appropriate setting for the selected option.

GGGG Repeat steps EEEE – FFFF for all options.

HHHH After making all option settings, click [OK].

----Using Adobe PageMaker Version 6.0 or 6.5

If you use the printer under Windows 95/98/Me, Windows 2000, Windows NT 4.0 with Adobe Page-

Maker, you need to copy the PPD file to the PageMaker folder. 

The PPD file is the file with extension ".ppd" on the CD-ROM. It is in the folder as follows: 

• Windows 95/98/Me

DRIVERS\PS\WIN9X_ME\(Language)\DISK1\

• Windows 2000

DRIVERS\PS\WIN2000\(Language)\DISK1\

• Windows NT 4.0

DRIVERS\PS\WIN\NT4\(Language)\DISK1\

The [WIN95_98] folder, inside the [PS] folder is for the Windows 95/98/Me operating system. Use the

folder at this level that is appropriate for the operating system you are using.

The third folder, "(Language)" may be substituted by an appropriate language name. 

Copy this file to the PageMaker folder.

For PageMaker 6.0 default installation, the folder is "C:\PM6\RSRC\PPD4", and for PageMaker 6.5

default installation, the directory is "C:\PM65\RSRC\USENGLISH\PPD4". The "USENGLISH" may

differ depending on your language selection.
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Macintosh

Macintosh - Installing the PostScript Printer Driver

It is necessary to install a printer driver and a PPD file to print from a Macintosh.

Follow these steps to install a printer driver and a PPD file into a Macintosh using MacOS 7.6.1 or later.

AAAA Insert the CD-ROM into the CD-ROM drive.

BBBB Double-click the CD-ROM icon.

CCCC Double-click the [PS] folder.

DDDD Double-click the folder of the language you use.

EEEE Open [DISK1], and then double-click the installer icon.

FFFF Follow the instructions on the screen.

GGGG Double-click [Extensions].

HHHH Double-click [Printer Descriptions].

IIII Double-click the CD-ROM icon on the desktop.

JJJJ Double-click [DISK1] in the folder of the language you use.

KKKK Drag the PPD file into [Printer Descriptions].

LLLL Drag the Plugin file into [Printer Descriptions] in [Extensions] in [System Folder].

MMMM Restart the Macintosh.
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Setting Up the PPD File

Preparation

❒ Confirm that the printer is connected to an AppleTalk network before performing the following pro-

cedure.

AAAA On the [Apple] menu, select [Chooser].

BBBB Click the [Adobe PS] icon.

CCCC In the [Select a PostScript Printer:] list, click the name of the printer you want to use.

DDDD Click [Create].

EEEE Click the printer you want to use, and then click [Select].

The PPD file is set up, and the [Adobe PS] icon appears at the left of the printer name in the list.

Next, follow the procedure on p.15 “Setting Up Options” to make the option settings, or close the

[Chooser] dialog box.

Setting Up Options

AAAA On the [Apple] menu, select [Chooser].

BBBB Click the [Adobe PS] icon.

CCCC In the [Select the PostScript Printer:] list, click the name of the printer you want to use, and then

click [Setup].

DDDD Click [Configure].

A list of options appears.
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EEEE Select the option you want to set up, and then select the appropriate setting for it.

Note

❒ If the option you want to set up is not displayed, the PPD file might not be set up correctly. Check

the name of the PPD file shown in the dialog box.

FFFF Click [OK].

The list of options closes.

GGGG Click [OK].

The [Chooser] dialog box appears.

HHHH Close the [Chooser] dialog box.

Installing the ColorSync profile

ColorSync profile make it possible for the printer to print colors of similar intensity to those that appear

on your computer display. You must install the ColorSync profile to use this feature.

Note

❒ The ColorSync profile conform with the color characteristics defined by the International Color Con-

sortium (ICC).

❒ Some computer displays may require particular settings to be controlled by ColorSync. See the doc-

umentation that comes with your display for details.

The following procedure shows how to install the ColorSync Profile.
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AAAA Start the Macintosh.

BBBB Double-click the hard disk icon, and then open the appropriate folder for installing the Color-

Sync profile.

Note

❒ The location of the appropriate folder may differ depending on the version of the operating sys-

tem. The following are examples:

• System:Preferences:ColorSync Profiles

• System:ColorSync Profiles

CCCC Insert the CD-ROM into the CD-ROM drive.

The icon of the CD-ROM appears.

DDDD Double-click the CD-ROM icon.

The contents of the CD-ROM appear.

EEEE Double-click the [ColorSyncTM Profiles] folder in the CD-ROM.

FFFF Drag the file to the [ColorSyncTM Profiles] folder on the hard disk.

The ColorSync profile is installed.
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Uninstalling the PostScript Printer Driver

This section describes how to uninstall the PostScript printer driver.

The actual procedure may differ depending on the operating system.

Follow the appropriate procedure below.

Windows 95/98/Me - Uninstalling the PostScript Printer Driver

AAAA Close all applications that are currently running. 

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

CCCC Click to select the icon of the printer you want to remove. 

DDDD On the [File] menu, click [Delete].

A confirmation dialog box appears.

EEEE Click [Yes] to uninstall the printer driver.
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Windows 2000 - Uninstalling the PostScript Printer Driver

Limitation

❒ Uninstalling a printer driver requires Manage Printers permission. Members of the Administrators

and Power Users groups have Manage Printers permission by default. When you uninstall a printer

driver, log on using an account that has Manage Printers permission.

AAAA Close all the applications that are currently running.

BBBB Click [Start] on the taskbar, point to [Settings], and click [Printers].

The [Printers] window appears.

CCCC Click to select the icon of the printer you want to remove.

DDDD On the [File] menu, click [Delete].

A confirmation dialog box appears. 

EEEE Click [Yes] to uninstall the printer driver.
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Windows NT 4.0 - Uninstalling the PostScript Printer Driver

Limitation

❒ Uninstalling a printer driver requires Full Control access permission. Members of the Administrators,

Server Operators, Print Operators, and Power Users groups have Full Control Permission by de-

fault. When you uninstall a printer driver, log on using an account that has Full Control permission.

AAAA Close all applications that are currently running. 

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

CCCC Click to select the icon of the printer you want to remove. 

DDDD On the [File] menu, click [Delete].

A confirmation dialog box appears.

EEEE Click [Yes] to uninstall the printer driver.
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Installable Options

The following options are available.

❖❖❖❖ Paper Feed Unit

• 500 sheets x 1 Tray

• 500 sheets x 2 Tray

• 2000 sheets LCT

❖❖❖❖ Output Paper Device

• Duplex Unit

• Mailbox

• Finisher

• Finisher with Punch

• Finisher with Staple

❖❖❖❖ Memory Unit

• Printer Hard Disk

• SDRAM
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Printing a Document

This section describes how to print a document using printer specific functions.

❖❖❖❖ Color Mode
The following table shows the tabs or menus where you can select this function.

Important

❒ When you use Windows 95/98/Me, you can configure this function from “Color/Black and White”.

Note

❒ Use this to set the output color to [Black and White] or [Color].

❖❖❖❖ Color Setting
The following table shows the tabs or menus where you can set the correction method used for color

conversion.

Important

❒ When you use Windows 95/98/Me, you can configure [Color Setting] in [Advanced] by selecting

[Manual] from the [Color] setting. [Automatic] sets the printer to "Super Fine".

Windows 95/98/Me [Setup] tab

Windows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the 

Printing Preferences Properties

Windows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] tab

Macintosh [Printer Specific Options] in the print dialog box
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Note

❒ The color rendering dictionary that is selected in the “Color Profile” setting is used.

❒ Use this setting to set the correction method used for color conversion. The following items are

available: [Off] *1  , [Fine] *2  , [Super Fine] *3  . 
*1 No modification to the color setting.
*2 Select this setting to perform color matching based on one of the printer's built-in color rendering dic-

tionaries and perform CMYK conversion. This setting perform the printing which output target is
Moritor γ = 1.8.

*3 Select this setting to use a color rendering dictionary as in the "Fine" setting but produce output that
is more vivid. Use this setting to emphasis light colors. This setting perform the printing which output
target is Moritor γ = 2.2.

Windows 95/98/Me [Advanced] on the [Print Quality] tab

Windows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the 

Printing Preferences Properties

Windows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] tab

Macintosh [Printer Specific Options] in the print dialog box
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❖❖❖❖ Color Profile
The following table shows the tabs or menus where you can select this function.

Important

❒ When you use Windows 95/98/Me, you can configure [Color Profile] in [Advanced] by selecting

[Manual] from the [Color] setting. [Automatic] sets the printer to "Presentation".

Note

❒ Use this to select a color rendering dictionary (CRD). The CRD is referred to for color matching,

so you should select the appropriate CRD for the document you are printing. The CRD you select

is also referred to when [Fine] or [Super Fine] is selected for “Color Setting”. The following items

are available: [Photograph] *1 , [Presentation] *2  and [Solid Color] *3 .
*1 Use this setting to enhance the reproduction of photos and graphics that include midtones.
*2 Use this setting to enhance the reproduction of documents that contain text and graphics. This CRD

is best for printing colored charts, graphs, presentation materials and so on. If you use this CRD for
printing photographs, the color or gradations might not be reproduced well.

*3 Use this setting to print specific colors, logos and so on.

Windows 95/98/Me [Advanced] on the [Print Quality] tab

Windows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the 

Printing Preferences Properties

Windows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] tab

Macintosh [Printer Specific Options] in the print dialog box



Operating Instructions

25

❖❖❖❖ Gradation
Use this to set the printing mode to [Standard] or [Fast].

Limitation

❒ When the resolution option is set to [1200dpi], the gradation option must be set to [Fast].

❖❖❖❖ Resolution
Use this to set the resolution to [600dpi] or [1200dpi].

Limitation

❒ When the resolution option is set to [600dpi] and gradation option is set to [Fast], the outputs will

be printet with 600 × 600dpi.

❒ When the resolution option is set to [600dpi] and gradation option is set to [Standard], the outputs

will be printet with 1200 × 600dpi.

Windows 95/98/Me [Advanced] on the [Print Quality] tab

Windows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the 

Printing Preferences Properties

Windows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] tab

Macintosh [Printer Specific Options] in the print dialog box

Windows 95/98/Me [Advanced] on the [Print Quality] tab

Windows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the 

Printing Preferences Properties

Windows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] tab

Macintosh [Printer Specific Options] in the print dialog box
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❖❖❖❖ Dithering
Use this to set the image rendering mode.

Important

❒ When you use Windows 95/98/Me, you can configure [Dithering] in [Advanced] by selecting [Man-

ual] from the [Color] setting. [Automatic] sets the printer to "Photographic".

Windows 95/98/Me [Advanced] on the [Print Quality] tab

Windows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the 

Printing Preferences Properties

Windows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] tab

Macintosh [Printer Specific Options] in the print dialog box
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❖❖❖❖ Gray Reproduction (Black Text/Graphics)
Use this to select the black color mode for text and line art.

Important

❒ When you use Windows 95/98/Me, you can configure [Gray Reproduction] in [Advanced] by select-

ing [Manual] from the [Color] setting. [Automatic] sets the printer to "Pure Black Text".

Note

❒ Use this to select [K] *1  *2  or [CMY+K] *3 .
*1 Select this setting to use a black toner.
*2 When you use Windows 95/98/Me,  this mode is called “Pure Black Text”.
*3 Select this setting to use all toners.

Windows 95/98/Me [Advanced] on the [Print Quality] tab

Windows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the 

Printing Preferences Properties

Windows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] tab

Macintosh [Printer Specific Options] in the print dialog box
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❖❖❖❖ Black Over Print
Select whether or not to apply a black color over any other colors when printing.

This is useful when a white opening in background is noticeable in black text and graphics.

Important

❒ When you use Windows 95/98/Me, you can configure [Black Over Print] in [Advanced] by selecting

[Manual] from the [Color] setting.

❖❖❖❖ Paper Source
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Advanced] on the [Print Quality] tab

Windows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the 

Printing Preferences Properties

Windows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] tab

Macintosh [Printer Specific Options] in the print dialog box

Windows 95/98/Me [All Pages] on the [Paper] tab

Windows 2000 [Paper/Quality] tab in the Printing Preferences Properties

Windows NT 4.0 [Page Setup] tab

Macintosh [General] in the print dialog box
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❖❖❖❖ Destination Tray
The following table shows the tabs or menus where you can select this function.

❖❖❖❖ Duplex Printing
Use this function to select duplex printing.

Limitation

❒ To use this function, the Duplex Unit must be installed on the printer.

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Destination] on the [Paper] tab

Windows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the 

Printing Preferences Properties

Windows NT 4.0 [Printer features] on [Document Options] on the [Advanced] tab

Macintosh [Printer Specific Options] in the print dialog box

Windows 95/98/Me [Duplex] on the [Setup] tab

Windows 2000 [Print on Both Sides (Duplex)] on the [Layout] tab in the Printing 

Preferences Properties

Windows NT 4.0 [Page Setup] tab

Macintosh [Print on Both Sides] on [Layout] in the print dialog box



Operating Instructions

30

❖❖❖❖ Collate
Use this function to enable collation. With this feature, the printer can efficiently print collated sets

of multiple-page documents.

Limitation

❒ To use this function, a Memory Unit of at least 128MB or Hard Disk Drive must be installed on

the printer.

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Collate] on the [Setup] tab

Windows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the 

Printing Preferences Properties

Windows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] tab

Macintosh [Printer Specific Options] in the print dialog box
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❖❖❖❖ Staple
Use this function to have the output stapled. When you turn Staple on, the printed document is col-

lated automatically. You should switch off Collate from the Print window of your application to pre-

vent the entire job from being stapled together. 

Limitation

❒ To use this function, the finisher must be installed on the printer.

Reference

❒ For more information, see the Printer Client Reference 2.

The following table shows the tabs or menus where you can select this function.

*1 You must select "Finisher Shift Tray 1" or "Finisher Shift Tray 2" for the destination tray setting.

Windows 95/98/Me [Staple] on the [Setup] tab

Windows 2000 *1 [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the 

Printing Preferences Properties

Windows NT 4.0 *1 [Printer features] on [Document Options] on the [Advanced] tab

Macintosh *1 [Printer Specific Options] in the print dialog box
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❖❖❖❖ Punch
Use this function to have the output punched.

Limitation

❒ To use this function, the finisher with punch must be installed on the printer.

Reference

❒ For more information, see the Printer Client Reference 2.

The following table shows the tabs or menus where you can select this function.

*1 You must select "Finisher Shift Tray 1" or "Finisher Shift Tray 2" for the destination tray setting.

❖❖❖❖ Toner Saver
Use this function to reduce the amount of toner used when printing.

Note

❒ This will have low toner consumption, so that the output will appear slightly ligter.

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Punch] on the [Setup] tab

Windows 2000 *1 [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the 

Printing Preferences Properties

Windows NT 4.0 *1 [Printer features] on [Document Options] on the [Advanced] tab

Macintosh *1 [Printer Specific Options] in the print dialog box

Windows 95/98/Me [Toner Saver] on the [Print Quality] tab

Windows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the 

Printing Preferences Properties

Windows NT 4.0 [Printer features] on [Document Options] on the [Advanced] tab

Macintosh [Printer Specific Options] in the print dialog box
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❖❖❖❖ Sample Print
Use this function to print only one set of a multiple print job.

The other sets are saved in the machine. The saved job can be printed from the machine's operation

panel. You can also delete the saved job.

Limitation

❒ To use this function, the Hard Disk Drive must be installed on the printer.

Note

❒ The “User ID” can consist of up to eight alphanumeric (a-z, A-Z, 0–9) characters.

❒ Entering the “User ID” helps you to distinguish the print job from others.

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Job Type] on the [Setup] tab

Windows 2000 [Job Type] on the [Job/Log] tab

Windows NT 4.0 [Job Type] on the [Job/Log] tab

Macintosh [Job Log] in the print dialog box
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❖❖❖❖ Locked Print
Use this function to save documents in the machine memory with a password, and then edit and print

them as you want.

Limitation

❒ To use this function, the Hard Disk Drive must be installed on the printer.

Note

❒ The “User ID” can consist of up to eight alphanumeric (a-z, A-Z, 0–9) characters. The “Password”

must be four digits.

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Job Type] on the [Setup] tab

Windows 2000 [Job Type] on the [Job/Log] tab

Windows NT 4.0 [Job Type] on the [Job/Log] tab

Macintosh [Job Log] in the print dialog box
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Sample Print

Follow the procedures below to print a document using the “Sample Print” function.

The following procedure uses the sample User ID: ABCD1234.

Windows 95/98/Me

Note

❒ If the application has a collate option, make sure that it is not selected before sending a print job. By

default, sample print jobs are automatically collated by the printer driver. If the collate option is se-

lected in the application print dialog box, more prints than intended may be printed.

AAAA From an application, select the menu command to print.

The print dialog box appears.

BBBB Open the Printer Properties.

CCCC Click to select the [Setup] tab.

DDDD Select [Sample Print] in the [Job Type].

EEEE Click the [Details...]

FFFF Enter the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)

characters. 

Note

❒ This is used to identify the user associated with a job.

❒ The "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters.
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GGGG Click [OK].

HHHH Click [OK] to close the Printer Properties.

IIII Start printing from the application's print dialog box.

The Sample Print job is sent to the machine and one set is printed.

JJJJ Check the sample print to confirm that the settings are all right.

If the settings are fine, go to step K to print the remaining sets.

If not, you can delete the saved job. ⇒ p.42 “Deleting a Sample Print file” 

KKKK On the machine's operation panel, press {{{{Menu}}}}.

LLLL Press {{{{UUUU}}}} or {{{{TTTT}}}} until the following message appears on the panel display.

MMMM Press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

NNNN Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to print, and then press {{{{Enter qqqq}}}}.

  Menu:

   Sample Print

  Sample Print:

  08:56 ABCD1234
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OOOO Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "Print File", and then press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

PPPP Press {{{{UUUU}}}} or {{{{TTTT}}}} to change the document quantity desired, and then press {{{{Enter qqqq}}}} to print

the file.

The following message appears on the panel display.

  Qty:  1(1-999)

  Press #To Print

  Processing...
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Windows 2000, Windows NT 4.0

Note

❒ If the application has a collate option, make sure that it is not selected before sending a print job. By

default, sample print jobs are automatically collated by the printer driver. If the collate option is se-

lected in the application print dialog box, more prints than intended may be printed.

AAAA From an application, select the menu command to print.

The print dialog box appears.

BBBB Open the Printer Properties.

CCCC Click to select the [Job/Log] tab.

DDDD Select [Sample Print] in the [Print Job].

EEEE Enter the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)

characters. 

Note

❒ This is used to identify the user associated with a job.

❒ The "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters.

FFFF Click [OK] to close the Printer Properties.

GGGG Start printing from the application's print dialog box.

The Sample Print job is sent to the machine and one set is printed.

HHHH Check the sample print to confirm that the settings are all right.

If the settings are fine, go to step I to print the remaining sets.

If not, you can delete the saved job. ⇒ p.42 “Deleting a Sample Print file” 
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IIII On the machine's operation panel, press {{{{Menu}}}}.

JJJJ Press {{{{UUUU}}}} or {{{{TTTT}}}} until the following message appears on the panel display.

KKKK Press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

LLLL Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to print, and then press {{{{Enter qqqq}}}}.

MMMM Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "Print File", and then press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

NNNN Press {{{{UUUU}}}} or {{{{TTTT}}}} to change the document quantity desired, and then press {{{{Enter qqqq}}}} to print

the file.

The following message appears on the panel display.

  Menu:

   Sample Print

  Sample Print:

  08:56 ABCD1234

  Qty:  1(1-999)

  Press #To Print

  Processing...
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Macintosh

AAAA From an application, select the menu command to print.

The print dialog box appears.

BBBB Click to select the [Job Log].

CCCC Select [Sample Print], and then select the appropriate setting.

DDDD Enter the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)

characters. 

Note

❒ This is used to identify the user associated with a job.

❒ The "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters.

EEEE After making all of the settings you want, click [Print].

The Sample Print job is sent to the machine and one set is printed.

FFFF Check the sample print to confirm that the settings are all right.

If the settings are fine, go to step G to print the remaining sets.

If not, you can delete the saved job. ⇒ p.42 “Deleting a Sample Print file” 

GGGG On the machine's operation panel, press {{{{Menu}}}}.
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HHHH Press {{{{UUUU}}}} or {{{{TTTT}}}} until the following message appears on the panel display.

IIII Press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

JJJJ Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to print, and then press {{{{Enter qqqq}}}}.

KKKK Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "Print File", and then press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

LLLL Press {{{{UUUU}}}} or {{{{TTTT}}}} to change the document quantity desired, and then press {{{{Enter qqqq}}}} to print

the file.

The following message appears on the panel display.

  Menu:

   Sample Print

  Sample Print:

  08:56 ABCD1234

  Qty:  1(1-999)

  Press #To Print

  Printing...
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Deleting a Sample Print file

If the printed document is not what you expected, you can delete the sample print file.

AAAA Press {{{{Menu}}}}.

BBBB Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "Sample Print", and then press {{{{Enter qqqq}}}}.

CCCC Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to delete, and then press {{{{Enter qqqq}}}}.

DDDD Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “Delete File”, and then press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

EEEE Press {{{{Enter qqqq}}}} to delete the file.

The following message appears on the panel display.

  08:56 ABCD1234

  Press # To Del.

  Deleted
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Locked Print

Follow the procedures below to print a document using the “Locked Print” function.

The following procedure uses the sample User ID: ABCD1234.

Windows 95/98/Me

AAAA From an application, select the menu command to print.

The print dialog box appears.

BBBB Open the Printer Properties.

CCCC Click to select the [Setup] tab.

DDDD Select [Locked Print] in [Job Type].

EEEE Click the [Details...]

FFFF Enter the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)

characters. Then enter a password in [Password], up to four digits. 

Note

❒ This is used to identify the user associated with a job.

❒ The "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters. The “Password”

must be four digits.

GGGG Click [OK].

HHHH Click [OK] to apply the settings you made.
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IIII After making all of the settings you want, click [OK] to close the Printer Properties.

The document file is saved in the printer.

If you want to print this document, go to step J to print the remaining sets.

If not, you can delete the saved job. ⇒ p.52 “Deleting a Locked Print file” 

JJJJ On the machine's operation panel, press {{{{Menu}}}}.

KKKK Press {{{{UUUU}}}} or {{{{TTTT}}}} until the following message appears on the panel display.

LLLL Press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

MMMM Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to print, and then press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

NNNN Press {{{{UUUU}}}} or {{{{TTTT}}}} to set the digit in the password entry field.

  Menu:

   Locked Print

  Locked Print:

  08:56  ABCD1234

  Password:

  [0---]
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OOOO Press {{{{Enter qqqq}}}}.

The pointer ( k ) moves to the next entry field automatically.

PPPP Repeat steps NNNN and OOOO to set the password.

Check if the pointer ( k ) is at the rightmost position, and then press {{{{Enter qqqq}}}} to register the pass-

word you selected.

QQQQ Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "Print File", and then press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

RRRR Press {{{{UUUU}}}} or {{{{TTTT}}}} to change the document quantity desired, and then press {{{{Enter qqqq}}}} to print

the file.

The following message appears on the panel display.

  Qty:  1(1-999)

  Press # To Print 

  Printing...
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Windows 2000, Windows NT 4.0

AAAA From an application, select the menu command to print.

The print dialog box appears.

BBBB Open the Printer Properties.

CCCC Click to select the [Job/Log] tab.

DDDD Select [Locked Print] in [Print Job].

EEEE Enter the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)

characters. Then enter a password in [Password], up to four digits. 

Note

❒ This is used to identify the user associated with a job.

❒ The "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters. The “Password”

must be four digits.

FFFF Click [OK] to apply the settings you made.

GGGG After making all of the settings you want, click [OK] to close the Printer Properties.

The document file is saved in the printer.

If you want to print this document, go to step H to print the remaining sets.

If not, you can delete the saved job. ⇒ p.52 “Deleting a Locked Print file” 

HHHH On the machine's operation panel, press {{{{Menu}}}}.
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IIII Press {{{{UUUU}}}} or {{{{TTTT}}}} until the following message appears on the panel display.

JJJJ Press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

KKKK Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to print, and then press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

LLLL Press {{{{UUUU}}}} or {{{{TTTT}}}} to set the digit in the password entry field.

MMMM Press {{{{Enter qqqq}}}}.

The pointer ( k ) moves to the next entry field automatically.

NNNN Repeat steps LLLL and MMMM to set the password.

Check if the pointer ( k ) is at the rightmost position, and then press {{{{Enter qqqq}}}} to register the pass-

word you selected.

  Menu:

   Locked Print

  Locked Print:

  08:56  ABCD1234

  Password:

  [0---]
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OOOO Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "Print File", and then press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

PPPP Press {{{{UUUU}}}} or {{{{TTTT}}}} to change the document quantity desired, and then press {{{{Enter qqqq}}}} to print

the file.

The following message appears on the panel display.

  Qty:  1(1-999)

  Press # To Print 

  Printing...
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Macintosh

AAAA From an application, select the menu command to print.

The print dialog box appears.

BBBB Click to select the [Job Log].

CCCC Select [Locked Print],and then select the appropriate setting.

DDDD Enter the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)

characters. Then enter a password in [Password], up to four digits. 

Note

❒ This is used to identify the user associated with a job.

❒ The "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters. The “Password”

must be four digits.

EEEE After making all of the settings you want, click [Print].

The Sample Print job is sent to the machine and one set is printed.

FFFF Check the locked print to confirm that the settings are all right.

If the settings are fine, go to step G to print the remaining sets.

If not, you can delete the saved job. ⇒ p.52 “Deleting a Locked Print file” 

GGGG On the machine's operation panel, press {{{{Menu}}}}.

HHHH Press {{{{UUUU}}}} or {{{{TTTT}}}} until the following message appears on the panel display.

  Menu:

   Locked Print
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IIII Press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

JJJJ Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to print, and then press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

KKKK Press {{{{UUUU}}}} or {{{{TTTT}}}} to set the digit in the password entry field.

LLLL Press {{{{Enter qqqq}}}}.

The pointer ( k ) moves to the next entry field automatically.

MMMM Repeat steps KKKK and LLLL to set the password.

Check if the pointer ( k ) is at the rightmost position, and then press {{{{Enter qqqq}}}} to register the pass-

word you selected.

NNNN Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "Print File", and then press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

  Locked Print:

  08:56  ABCD1234

  Password:

  [0---]

  Qty:  1(1-999)

  Press # To Print 
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OOOO Press {{{{UUUU}}}} or {{{{TTTT}}}} to change the document quantity desired, and then press {{{{Enter qqqq}}}} to print

the file.

The following message appears on the panel display.

  Printing...
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Deleting a Locked Print file

If the printed document is not what you expected, you can delete the Locked print file.

AAAA Press {{{{Menu}}}}.

BBBB Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "Locked Print", and then press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

CCCC Press {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to delete, and then press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

DDDD Press {{{{UUUU}}}} or {{{{TTTT}}}} to set the digit in the password entry field.

EEEE Press {{{{Enter qqqq}}}}.

The pointer ( k ) moves to the next entry field automatically.

FFFF Repeat steps DDDD and EEEE to set the password.

Check if the pointer ( k ) is at the rightmost position, and then press {{{{Enter qqqq}}}} to register the pass-

word you selected.

GGGG Press {{{{UUUU}}}} or {{{{TTTT}}}} to display "Delete File", and then press {{{{Enter qqqq}}}}.

The following message appears on the panel display.

  Password:

  [0---]

  08:56 ABCD1234

  Press # To Del.
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HHHH Press {{{{Enter qqqq}}}} to delete the file.

The following message appears on the panel display.

  Deleted
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Printer Utility for Mac

By using Printer Utility for Mac, you can download fonts, change the name of printer and so on.

Note

❒ Printer Utility for Mac is included on the CD-ROM labeled “Drivers and Utilities”.

❒ Printer Utility for Mac requires Mac OS 7.6.1 or later.

Installing Printer Utility for Mac

Follow these steps to install Printer Utility for Mac on the machine.

AAAA Start the Macintosh.

BBBB Insert the CD-ROM into the CD-ROM drive.

The icon of the CD-ROM appears.

CCCC Double-click the icon of hard disk to open it.

DDDD Double-click the CD-ROM icon.

The contents of the CD-ROM appear.

EEEE Double-click the [PS Utility] folder of the CD-ROM, and then drag the [Printer Utility for Mac]
file and drop it into the Macintosh hard disk.

FFFF Drag the CD-ROM icon and drop it into [Trash] to eject the CD-ROM.

Printer Utility for Mac is installed.
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Starting Printer Utility for Mac

The following instructions describe how to start Printer Utility for Mac.

Important

❒ Before starting Printer Utility for Mac, confirm that the printer is selected with [Chooser] on the Apple

menu.

AAAA Double-click the icon of Printer Utility for Mac.

The Printer Utility for Mac dialog box appears.

BBBB Click [OK].

Printer Utility for Mac will take a few seconds to start.

Reference

❒ For more information, see “Printer Utility for Mac Functions”. 

Printer Utility for Mac Functions

Printer Utility for Mac functions are described below.

❖❖❖❖ File menu

• [Download PS Fonts...]
Download fonts (PostScript Type 1) to the printer. See p.57 “Downloading PS Fonts”.

• [Display Printer's Fonts...]
Display and delete the fonts in printer memory and the printer's hard disk drive. See p.58 “Dis-

playing Printer's Fonts”.

• [Initialize Printer's Disk...]
Initialize the printer's hard disk drive. See p.60 “Initializing the Printer Disk”.
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• [Page Setup...]
Set up the paper size to print “Printer Font Catalog” and “Printer Font Sample”. See p.61 “Page

Setup”.

• [Print Font Catalog...]
Print the names of available fonts. See p.61 “Printing Font Catalog”.

• [Print Font Sample...]
Print a sample of fonts. See p.61 “Printing Font Sample”.

• [Rename Printer...]
Change the printer's name when viewed via Appletalk. See p.62 “Renaming the Printer”.

• [Restart Printer]
Restart the printer. See p.63 “Restarting the Printer”.

❖❖❖❖ Utility menu

• [Download PostScript File...]
Download a PostScript File. See p.63 “Downloading PostScript Files”.

• [Select Zone...]
Change the zone the printer belongs to via Appletalk. See p.64 “Selecting the Zone”.

• [Display Printer Status...]
Display the status of the printer. See p.65 “Displaying the Printer Status”.

• [Launch Dialogue Console...]
Create and edit a PostScript file, and download it to the printer. See p.65 “Launching the Dia-

logue Console”.
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Downloading PS Fonts

You can download the PS fonts to the printer's memory or hard disk drive.

Important

❒ The following procedures to download the fonts assumes that you are a system administrator. If you

are not, be sure to consult your system administrator.

❒ If the printer restarts, all the printer settings return to their defaults.

❒ Confirm that Macintosh and the printer are connected with Appletalk.

Note

❒ Some fonts cannot be downloaded.

❒ Before downloading, read the documentation of the fonts you want to use.

AAAA Select [Download PS Fonts...] on the [File] menu.

BBBB Click [Add to list].

The dialog box to select fonts appears.

CCCC Click to select the desired font files, and then click [Open].

The list of selectable font names appears.

DDDD After adding all the fonts you want to download, click [OK].

The dialog box of selected fonts to download appears.
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EEEE Click [Download].

The fonts begin to download, and the download status is shown.

Important

❒ During the download, do not turn off the power switch, operate the panel or open or close the

cover.

FFFF When the completion message appears, click [OK].

GGGG Click [Cancel].

Displaying Printer's Fonts

You can display the available fonts currently downloaded to the printer. Fonts in the printer's memory

and hard disk drive can be displayed.

Note

❒ The fonts displayed in italics are the default fonts.

AAAA Select [Display Printer's Fonts...] on the [File] menu.

A dialog box appears.

BBBB Select [Printer's memory] or [Printer's disk].

CCCC Click [OK].
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Deleting Fonts

You can delete fonts from the printer's memory or hard disk drive.

AAAA Select [Display Printer's fonts] on the [File] menu.

A dialog box appears.

BBBB Select the [Printer's memory] or [Printer's disk].

CCCC Select the fonts you want to delete.

Limitation

❒ You cannot delete the fonts displayed in italic.

DDDD Click [Delete].

A confirmation message appears.

EEEE Confirm the fonts you want to delete and the printer name from which you want to delete the

fonts.

FFFF Click [Continue], and then click [OK].

GGGG Click [OK].
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Initializing the Printer Disk

When initializing the printer's hard disk, all the fonts downloaded to the printer's hard disk drive and

deleted. Before initializing, be sure to check the fonts on the hard disk drive.

Important

❒ When initializing the printer's hard disk drive from the operation panel, all of the data on the printer's

hard disk drive is deleted. Before initializing, be sure to check the data on the hard disk drive.

AAAA Select [Initialize Printer's Disk...] on the [File] menu.

The confirmation message appears.

Note

❒ To cancel initialization, click [Cancel].

BBBB Click [Execute].

Initializing starts.

Important

❒ Do not turn off the power switch until initializing is completed, otherwise the hard disk drive might

be damaged.

CCCC When the completion message appears, click [OK].
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Page Setup

You can set the paper size on which to print “Print Fonts Catalogue” and “Prints Fonts Sample”.

AAAA Select [Page Setup...] on the [File] menu.

BBBB Choose the paper size.

Printing Font Catalog

Print the names of fonts available on the printer.

Note

❒ The paper selected under [Page Setup] is used.

AAAA Select [Print Fonts Catalogue] on the [File] menu.

BBBB Click [Print].

Printing Font Sample

You can print samples of fonts downloaded to the hard disk drive or memory.

Note

❒ Print by using the paper selected on [Page Setup].

AAAA Select [Print Fonts Sample...] on the [File] menu.

BBBB Click [Print].
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Renaming the Printer

You can change the printer's name displayed under Appletalk. If you connect several printers on the

network, assign different names so you can identify them. If several printers have the same name, a digit

appears next to the printer name in the [Chooser].

AAAA Select [Rename Printer...] on the [File] menu.

BBBB Type a new name in the [New Name:] field. 

Limitation

❒ You can enter up to 31 digits and letters.

❒ Do not use symbols, for example “*”, “:”, “=”,”@”, “~”.

CCCC Click [Rename].

The printer name is changed.

DDDD Press [OK].

EEEE Select [Chooser] on the Apple menu.

FFFF Click the icon of [AdobePS].

GGGG Click to select the printer name renamed in step BBBB and then close [Chooser].

Note

❒ If there are several Appletalk zone, select the zone the printer belongs to.
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Restarting the Printer

You can restart the printer.

AAAA Select [Restart Printer] on the [File] menu.

BBBB Confirm the message that appears on the screen, and then click [Restart].

The printer restarts.

Note

❒ The fonts that you downloaded in the printer's memory will be deleted.

❒ If the printer restarts, all the printer settings return to their defaults.

Downloading PostScript Files

You can download a Postscript file to the printer.

AAAA Select [Download PostScript File...] on the [Utility] menu.

BBBB Select the file name to download and click the file name, and then click [Open].

CCCC Type the log file name, and then click [Save].

The selected file is downloaded.

Note

❒ Errors are recorded in the log file.



Operating Instructions

64

Selecting the Zone

You can change the zone to which the printer belongs under Appletalk.

Important

❒ Confirm that the printer and a Macintosh are connected in an Appletalk environment.

AAAA Select [Select Zone...] on the [Utility] menu.

The zone to which the printer belongs and the available zone list appear.

BBBB Select the zone to which you want to switch the printer, and then click [Change].

A confirmation message appears.

CCCC Click [Continue].

A confirmation message appears.

DDDD Press [OK].

EEEE Select [Chooser] on the Apple menu.

FFFF Click the [AdobePS] icon.

GGGG Select the zone selected in step BBBB on the [Appletalk zone:].

HHHH Click to select the printer you want to use on the [Select a PostScript Printer:].

IIII Close [Chooser].
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Displaying the Printer Status

You can display and confirm the current status of the printer.

AAAA Select [Display Printer Status...] on the [Utility] menu.

The current status of the printer appears.

BBBB Confirm the current status of the printer.

You can confirm the memory capacity, the VM (Virtual Memory) space, the hard disk drive status

and available space on the hard disk drive. You can also confirm the zone to which the printer be-

longs to.

CCCC Click [OK].

Launching the Dialogue Console

You can create and edit a PostScript file for printing, and download it to the printer.

Important

❒ “Launch Dialogue Console” is recommended for users with an understanding of PostScript.

❒ Do not download any file other than PostScript files to the printer.

❒ “Launch Dialogue Console” must be used at your own responsibility.

AAAA Select [Launch Dialogue Console...] on the [Utility] menu.

Open the editing screen. The Dialogue Console menu bar appears.
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BBBB Type the PostScript command in the editor screen.

Note

❒ To edit a PostScript file, select [Open] on the [File] menu to open it.

❒ You can search or replace a character string by using the [Search] menu.

CCCC After editing the PostScript file, select [Download Top Window] on the [Console] menu to start

printing.

The PostScript file is sent to the printer.

Note

❒ The [Reply from Printer] box opens, depending on the PostScript file you sent.

DDDD Select [Return To Main Menu] on the [Console] menu to close the PostScript file.
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